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Introduction 
 
The AVANT ARC (Audiometer and Real Ear Measurement Combination) represents a new era of 
ultra-compact diagnostic audiometry and precision in-situ verification for your office. Compact 
yet rugged, this PC-Based system is USB powered and supports current ANSI and IEC 
audiometric and Real Ear tests. The software includes targets for DSL v5.0 and NAL-NL2. A 
unique feature of the Real Ear Measurement System is simultaneous, binaural Live Speech 
Mapping, MedRx’s in-situ method for getting the fitting right the first time, every time. The 
device performs Real Ear Measurements where measurements are performed directly on the 
client's ear. These measurements can be done with or without a hearing instrument being in 
place. The reason to perform Real Ear Measurements for hearing instrument fittings is that shape 
and size of an ear canal significantly influence a hearing instrument's performance. Knowing the 
sound intensity outside and inside the ear enables the practitioner to determine the actual 
amplification and output that the patient receives through the hearing aid and make the 
appropriate adjustments. 

 
This manual assumes that the system hardware, software and drivers are installed and working 
properly. Please refer to the MedRx AVANT ARC Installation Manual for assistance. The 
Installation Manual is included in the original AVANT ARC packaging in both printed and PDF 
formats. 
 
The scope of this manual is to get you “up and running” with the AVANT ARC System.  Please 
consult the interactive Help System within the software for more detailed information of 
features and functionality. To access this tool, press the F1 key at any time, or click the Help 
icon or text menu with your mouse. Access these by clicking on the “Help” tab at the top of the 
screen, and select “Help Topics”. Select an item from the list in the Index tab and click “Display”. 
 
Also refer to the Help files for test signal characteristics, analysis, equalization methods and the 
effects of analyzer settings on accuracy.   
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The AVANT ARC Software Overview 
 
The AVANT ARC Software can run stand-alone or through the NOAH™ System or the TIMS®  
Office System.   
 
 

Launching the Software 
 

Stand Alone NOAH and TIMS 
 

 

  
 
 

1. Launch NOAH. 
 
 

2. Select Client. 
 
 

3. In NOAH 4:  
• Click AVANT AUDIOMETER or 

AVANT REM icon on the toolbar. 
 

  
 
 

 
 

1. Double Click the AVANT AUD or 
AVANT REM shortcut on your 
Windows Desktop. 

Basic Audiometer Software Options 
Several option screens are available which allow the user to customize the AVANT ARC 
Audiometer Software to meet their needs. 

 
 

Access these Options from the File Menu 
on the AVANT ARC’s Audiometer Main Screen 
as shown below. 
 

 

The Options may also be accessed from the 
Audiometry screen by clicking Options on 
the menu as shown below. 
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The screen shots below detail the Basic Options available. 
 

  
 

The View tab allows you to set the 
default appearance of the test screen. 

 

The Audiometry tab sets the look and 
behavior of the AVANT ARC Audiometer.   
 

Basic REM (Real Ear Measurement) Software Options 
Several option screens are available which allow the user to customize the AVANT ARC REM 
Software to meet their needs. 
 

Access these Options from the File Menu on 
the AVANT ARC’s REM Main Screen as shown 
below. 

 

The Options may also be accessed from within 
the Avant REM audio screen by clicking on the 
Options text menu as shown below. 

 
 

The screen shots below detail the Basic Options available. 
 

  
 

The View tab allows you to set the default 
appearance of the REM test environment. 
Defaults can be changed by using the check 
boxes and pull-down menus shown above. 

The Live Speech tab sets the look and 
behavior of the Live Speech Mapping function. 
Use the Show Targets pull-down to change to 
DSL 5.0 or NAL- NL2 targets. 
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The REM tab sets the default look and behavior 
of conventional Real Ear Measurements. 

The MHA/HLS tab sets the default look and 
behavior of the Master Hearing Aid and 
Hearing Loss Simulator. 

NOTE: Remember, that more information is always available in the Interactive Help System by 
clicking the Help Icon or pressing the F1 key. 
 

Advanced Options 
The Advanced Options screen allows 
you to configure your system to meet your 
individual clinical needs. It also provides 
MedRx Technical Support with tools for 
helping you troubleshoot technical issues. 
Access this screen from the File Menu on 
the AVANT ARC’s REM or Audiometer Main 
Screen as shown to the right. 
 

 

 

The key features of each tab are described below. For more in-depth information, consult the  
interactive Help system within the software by pressing the F1 key or clicking the Help icon. 

 
 

The General Tab configures 
the overall Avant ARC 
behavior with respect to other 
Windows programs, 
specifically NOAH. 
 

 

 
 

Use the Audio-A Tab to select 
the proper audio device for 
your Avant ARC. This tab also 
provides access to the 
Windows Audio controls. 

 
 

Use the Audio-B Tab to select 
the proper audio device for 
your AVANT ARC. This tab also 
provides access to the 
Windows Audio controls. 
 
 

NOTE: The device settings may vary with different computers. Consult technical support before 
changing. 
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If your system has a Tympanometer 
connected, use the Tympanometry tab to 
configure the equipment according to the 
manufacturer’s instructions. 

 
 
If your system has a Video Otoscope, the 
Video Tab allows you to select the appropriate 
input device. 
 

ARC Accessories 
Use the accessories provided with your Avant ARC. Typical acceptable transducers are shown  
on the “Connecting  the Peripherals” page in the training manual. Operator headsets for use 
with the Avant ARC should have 32 ohms impedance and the speaker power should be at least 
50 watts. Air conduction transducers for use with this device should have an impedance of 10 
ohms. The speaker voltage should match the local outlet power where the device is used.  

The Operator Headset with microphone is used by the operator to communicate with the 
patient.  The patient talks to the operator using the Talk-Back microphone.  
  

Placing the Earphones on the Patient 
The AVANT ARC Audiometer standard configuration includes IP30 Insert Earphones. 3A Insert 
Earphones, DD45 or TDH 39 earphones are also available by request. The figures below illustrate 
how to properly place these earphones on the patient. 

Insert Earphones  

IMPORTANT: The foam tips used for the insert earphones are for SINGLE PATIENT USE ONLY.  
Do not attempt to wash and re-use them. 

 

 

1. Place a new set of foam tips on the earphone tubes as 
shown.  These tips are designed for single patient use and 
should not be washed and reused. 

• NOTE: When removing foam tips after use, be sure the 
clear plastic tubing nipple remains attached to the long 
earphone tube. 
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2. Carefully compress the tip 
between your fingers to allow it 
to fit into the patient’s ear canal 
as shown.  Do not roll the tip 
between your fingers. 

 

 

3. Pull up and back on the patient’s 
pinna to straighten the ear canal. 

4. Place the compressed foam tip 
deep within the ear canal. 

5. When properly placed, the outer 
surface of the insert tip will be 
flush with the opening of the ear 
canal as shown. 

 

DD45 or TDH 39 Earphones 
 

  

1. Place the earphones on the 
patient’s head so the center of 
the earphone  
is directly over the opening of 
the ear canal.   
 

2. Adjust the headband so the 
earphones remain in place, but 
be careful not to make it so tight 
as to cause patient discomfort. 

3.  

Placing the Bone Conductor 

 

1. Locate the mastoid process behind the pinna.  
This is a bony prominence just behind where the 
ear meets the head. 
 

2. Carefully place the bone conductor on the 
mastoid process and hold it in place. 
 

3. Place the headband over the head to the 
opposite temple. 
 

4. Carefully and slowly loosen your grip to check if 
the bone vibrator and headband will stay in 
place. 
 

5. If either moves, reposition until both the 
headband and bone vibrator are secure. 
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Performing Audiometric Testing 
From the AVANT ARC main screen, click on the “Audiometry” tab to access the audiometry 
function. The screen shot below shows the controls which are available from the AVANT ARC 
Audiometer main window. The sections of the manual that follow explain how to use these tools 
to perform hearing evaluations using your AVANT ARC Audiometer. 
 

 
 
 

1. Test Selection Tool Bar 
2. Journal or Notepad 
3. Monitor Headset Control 
4. Ear Selection 
5. Output selectors 
6. Test Type Selectors 
7. Tone Type Selectors 
8. Output Level Potentiometers  
9. Masking Interrupter and Routing Selector 
10. No Response Button 
11. Patient Response Indicator 

 
 

 

12. Test Interrupter 
13. Back to the Main Screen 
14. Help 
15. Discard Current Measurement 
16. Talk Over 
17. Legend 

To exit the program, click on the “Back” button then click “Exit”. 
 
 
  

3 
4 

5 

6 

7 

8 9 

13 14 15 16 

17 

10 
 

11 12 
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Pure Tone Audiometry 
Pure Tone Audiometry measures the patient’s peripheral hearing sensitivity, or the softest levels 
they can hear pure tones at a variety of frequencies. These thresholds are plotted on a standard 
graph called an audiogram. The AVANT ARC software controls the hardware, stores the data  
(if running within NOAH or TIMS) and prints a standard audiogram report. Pure tone Audiometry 
can be performed via earphones, free field speakers (Air Conduction) or a Bone Conductor (Bone 
Conduction). Warble settings are adjustable by the Operator. The Sound Field must be 
calibrated on-site, using 4 ohm speakers connected to the Free Field connectors. 

Pretesting Procedures/Recommendations: 

• Before performing audiometry, careful inspection of the ear canal should be performed. 
This is best done with Video Otoscopy.  After ensuring the ear canal is clear, place the 
appropriate transducer on the patient as shown on pages 8 & 9. 

Pure Tone Audiometry via Earphones (IP30 Inserts, 3A Inserts, DD45 or TDH 39) 

1. From the Main Screen, click the   button on the right side menu bar. 

2. By default, the  button will be selected once you enter the main Audiometry 
Screen.   
Other default settings (based on typical clinical practice and procedures) are: 

• Right Ear 
• AC (Air Conduction) 
• Tone Stimulus 
• Continuous Tone 

3. Instruct the patient that they will hear several very quiet (soft) tones (beeps) and that 
they should signal (raise their hand, press the patient response button, etc.) as soon as 
they hear it.  It is helpful to also say “even if it seems very far away”. 

4. Begin at 1000 Hz in the Right ear (unless the patient reports better hearing in the left ear). 

5. Present a tone at 60 dB by pressing and holding the space bar or clicking and holding the  

 button. 

6. If the patient does not hear the tone (does not signal), raise the level 5 dB using the up 

arrow on your keyboard or by clicking the    button and present again. 

7. Repeat step 6 until the patient signals that they hear the tone. 

8. When the patient signals they hear the tone, decrease the level by 10 dB using the down 

arrow on your keyboard or by clicking the  button and present the tone again. 

9. Repeat steps 6 through 8 until the patient responds to a tone at the same level 2 times 
with the level ascending and establishing a threshold. 
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10. Using the right arrow key, change the test frequency to 2000 Hz and repeat steps 5 
through 9 to establish the threshold at 2000 Hz. The threshold at the previous frequency 
is recorded when the test frequency is changed. 

• NOTE: If the threshold at 2000 Hz is more than 20 dB different (less than or greater 
than) the threshold at 1000 Hz, repeat steps 5 through 9 at 1500 Hz (the “half 
octave” between 1000 Hz and 2000 Hz). 

11. Repeat steps 5 through 9 for 4000 Hz, 8000 Hz, 500 Hz and 250 Hz. Testing half octaves as 
needed. 

12. Repeat steps 4 through 11 in the opposite ear. 

NOTE: The software automatically calculates the 3-frequency Pure Tone Average (PTA) which is 
displayed above and inside the legend as follows:                 
 

    

 
Pure Tone Audiometry via the Bone Conductor 

1. Following the instructions on page 11, place the Bone Conductor on the mastoid process 
behind the ear with better air conduction thresholds as measured above.  If the 
thresholds are equal, place the Bone Conductor on the mastoid process behind the right 
ear. 
 

2. Establish pure tone bone conduction thresholds as described above for 1000 Hz, 2000 Hz, 
4000 Hz, 500 Hz and 250 Hz. 
 

3. If the Bone Conduction (BC) threshold at a given frequency is less (better) than the Air 
Conduction (AC) threshold by 15 dB or more, you must confirm the threshold by 
performing masking. Masking is always recommended for frequencies above 2000 Hz to 
achieve valid results. 
 

4. Repeat steps 1-3 for opposite ear. 
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Masking for Pure Tone Audiometry 

There are several accepted methods for masking.  This manual will not promote one over 
another, however, to use the masking function on the AVANT Audiometer – Avant  ARC, follow 
the steps below. 

 
1. Click the Masking button. The red light will 

appear indicating that the masking is on. 

    

 

2. Use your mouse to adjust the Masking Level 
slider shown on the left to the appropriate level 
based on your preferred method of masking.  
 
 
 
 
 
 
 

3. If you wish to maintain the balance of signal and 
masking (for example, masking always 15 dB 
above the signal), click the Lock button after 
setting the masking and signal levels. 

 

 

4. The default for pure tone audiometry is to deliver 
narrow band masking to the ear opposite the 
test ear. If you wish to use a different stimulus, or 
route the masking to the same or both ears, click 
on the arrow to the right of the Masking On 
button. 
 

5. Use your mouse to select the new masking type 
and routing for your specific application. 
 

6. When you are finished making changes to the 
Masking, click Close. 
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Speech Audiometry 
Speech audiometry evaluates how well the patient can hear and understand speech. The typical 
test battery includes tests of speech thresholds and tests of speech discrimination.  

The sections below detail how to perform these tests on the AVANT ARC Audiometer. 

Speech Reception Threshold (SRT) 

The Speech Reception Threshold (SRT) is defined as the lowest dB level at which the patient can 
repeat Spondee words with at least 50% accuracy.  Spondee words are two syllable words with 
equal vocal emphasis on each syllable such as “baseball” or “hotdog”. 

Instruct the patient that they will hear a series of two-syllable words that will get quieter as the 
test progresses.  They are to repeat the words as best they can, even if they sound very far away.  
If they are not sure of a word, they should take a guess. 

SRT is typically within +/- 5 dB of the patient’s PTA which is displayed on the lower left corner of 
the screen.  Set the level of the test signal to “a level of familiarization”, done typically 20 dB 
above the PTA. 

 

 

1. From the AVANT Audiometer main 
screen, click the Audiometry button. 

 

 

2. Click the SRT button located on the 
toolbar on the top of the screen. 

 
 

 

 

3. Select the appropriate test ear icon. 

 

 

 

 

 

 

4. Click the Word List button. 
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5. Select Spondee Word Lists A&B from 
the list. 
 

6. Click Start Test. 

 
 

 

7. Click the Play button or press the F9 key 
to present a word.  The word will play 
through the chosen transducer as well as 
display on the screen. 

 

8. If the patient correctly repeats the word, 
click the Correct icon or press F7. 

9. If the patient incorrectly repeats the word, 
click the Incorrect icon or press F8. 

NOTE: that the score is calculated and displayed automatically in the bottom right corner of 
the screen.  

If the patient exceeds a 50% score at a given presentation level, stop the test and decrease 
the level by 10 dB and repeat the steps above. 

If the patient fails to achieve a 50% score after 6 words at a given level, stop the test, raise the 
level 5 dB and repeat the steps above.  

When the patient scores 50% at a given level, the test is complete.  The software 
automatically plots the score on the SRT graph. 

Repeat test on opposite ear. 
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Speech MCL & Speech UCL  
The patient’s most Comfortable Level and Uncomfortable Level for speech can be obtained 
while you are in Work Recognition (WR). 
 

 

1. From the Avant main screen,  
Click the Audiometry button. 

 

 

2. Click the WR button located on  
the toolbar on the top of the screen. 

 

 

3. Click UCL or MCL. 

 

 

4. Choose an input option. 

 

 

 

5. If you selected File or CD, select the  
track you would like to play for the  
test in the media player at the  
bottom of the screen. 

When you have selected your track in the 
media player, click play on media player or 
hit the spacebar to start.  
 
Adjust levels up or down with keyboard 
arrows or by clicking below the dB level at 
the bottom of the graph. 

 

 
 

 
 

 
6. To Input & Calibrate the Rainbow Passage 

in WR for MCL: 
 

a. Press small Green file folder in bottom 
left of media player. 

 
b. Select Rainbow Passage by double 

clicking twice. 
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c. Use the drop down in the media player 
and select track 10 – Calibration 
(1000Hz). 

 
 
 
 

d. Click play or start signal. 
 
 
 
 

e. On the VU meter at the top of the 
screen, press the slider calibration icon 
just below and to the left of the VU 
meter. 
 

f. Adjust with mouse or arrow keys so that 
the blue bar stops over the black arrow 
and there is no red. 

 
g. Click on the channel icon just below 

and to the right of the VU to switch 
channels. 

 
h. Repeat steps d - f for the remaining 

channel. 
 
Note: This calibration also needs to be 
done with any custom word list. 

 

 
 

 

 
7. When using the Mic or live voice option 

make sure you press the Start Signal or 
space bar to begin.  

 

 
 

8. When using the Mic option adjust your 
input using the slider so that it is peaking at 
the black triangle under the VU meter.   
 
The VU meter is at the top of the MedRx 
Software and will become active once you 
press Start Signal.  
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Word Recognition (WR) 
Speech Discrimination or Word Recognition (WR) is a discrimination type test using speech as 
the stimulus.  WR testing measures the percentage of mono-syllable words repeated correctly 
from a list.  Unlike the SRT test, the WR test is performed at a fixed intensity (dB) level.  WR is 
typically performed at a patient’s speech MCL. If MCL is not performed, system default options 
include, PTA, PTA+20, PTA+30 and PTA+40.  

Before beginning the test, instruct the patient that they will hear a series of one-syllable  
words.  They are to repeat the words as best they can.  If they are not sure of a word, they should 
take a guess. 

 
 

1. From the AVANT Audiometer main screen, click 
the Audiometry button. 

 

2. Click the WR button located on the toolbar on 
the top of the screen. 

 
 

3. Select the appropriate test ear icon. 

 
 

4. Click the Word List button. 

 
 

5. Select the desired Word List from the list. The W-
22 or NU-6 lists are good choices for most adult 
patients.  When testing children, the PBK lists 
should be used. 
 

6. Click Start Test. 

 

7. Click the Play button or press the F9 key to 
present a word.  The word will play through the 
chosen transducer as well as display on the 
screen. 

 

8. If the patient correctly repeats the word, click 
the Correct icon or press F7. 

9. If the patient incorrectly repeats the word, click 
the Incorrect icon or press F8. 

 10. The next word will automatically play when the 
previously presented word is scored. 

 
Note that the score is calculated and displayed automatically. The test is complete when all words in the 
list have been presented.  The software automatically plots the score on the WR graph. 

Repeat test on opposite ear. 
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QuickSIN (Optional) 

 
The primary complaint of hearing-impaired persons is difficulty hearing in background noise. 
The measurement of SNR loss (signal-to-noise ratio loss) is important because speech 
understanding in noise cannot be reliably predicted from the pure tone audiogram (Killion & 
Niquette, 2000).  
 The QuickSIN test was developed to:  

1. Provide a one-minute estimate of SNR loss.  
2. Provide a quick way for clinicians to quantify a patient’s ability to hear in noise.  
3. Determine if extended high frequency emphasis improves or degrades understanding of 

speech in noise.  
4. Assist professionals in choosing appropriate amplification and other assistive 

technologies.  
5. Demonstrate that hearing aids with directional microphones improve speech 

intelligibility in noise.  
6. Provide a large number of equivalent test lists for use in clinical and research work.  
7. Provide information useful in counseling patients regarding realistic expectations.  

The screenshot below shows the key features of the QuickSIN 
test. 
 

1. Calibration Button  
2. Ear Selector 
3. Output Selector 

 

4. List Selector 
5. Track Display 
6. Track Control 
7. Test Type Selector 
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Performing the QuickSIN Test 

 

• From the Avant  main 
screen, click the 
Audiometry icon. 

 

• Click the QuickSIN 
button on the top of 
the Audiometry 
screen. 

 
Present the test with earphones or in a sound field. The attenuator dial is set to 70 dB HL. For subjects with 
PTA hearing losses greater than 45 dB HL, the attenuator dial is set to a level that is “loud but OK.”, this is 
done by the program using the MCL value. A warning legend at the bottom of the window is shown if PTA is 
not available. Instruct the patient to repeat the sentences spoken by the target (female) talker. When testing 
in a sound field, have the patient hold the talkback microphone close enough so that responses are clearly 
audible to the tester. 
 

 
 

1. Select a list from the List 
Selection Window one of 
the following two ways: 
 
• Click the list, then click Select. 

 
• Or Double-Click the list number. 

 
 

2. Play the first sentence in the 
list by clicking the Play 
button. 
Ask the patient to repeat 
the sentence. 
 

 

 
 

3. Score the patient’s response 
one of the following ways: 
 
• Click the check-box of each 

correct key word with your 
mouse.  This will record the 
total number of correct key 
words in the score pull-down. 
 

• Record the total number of 
correct key words using the 
score pull-down or by pushing 
1-5 key on the keyboard. 
 

4. Click the next sentence and then 
click Play or click >>. This will 
advance & play. 
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5. Repeat steps 2-4 until all 6 

sentences in the list have been 
played and scored. 

 

 

 
After all six sentences are 
scored, the following 
results are displayed: 
 

• Total SNR Loss in dB. 
• Recommendations. 

 
Additional information on interpreting the QuickSIN is available in the Interactive Help 
system.  Top access this, click the Help icon or press the F1 key. 
 

 
Tinnometer (Optional) 
Purpose of the Tinnometer 

Tinnitus is experienced by millions of people worldwide. The Tinnometer is designed to mimic 
the sounds of tinnitus in order to provide an accurate and flexible tinnitus assessment. Tinnitus 
Assessment increases patient rapport with the clinician when an equivalent tinnitus sound can 
be created. The Tinnometer can accurately create tinnitus sounds for fast and reliable tinnitus 
assessment. All test results should be used to help counsel the patient on their specific tinnitus 
and what the assessment has found. 

 
The Tinnometer test was developed to: 
 

1. Break away from the traditional limitation of tinnitus assessment with an audiometer 
2. Produce accurate and flexible sounds that mimic patient tinnitus 
3. Provide extended frequency ranges to more accurately match tinnitus sounds 
4. Decrease the time needed to complete a tinnitus assessment 
5. Standardize reporting needed when completing tinnitus assessment 
6. Allow clinicians to save and recall prior tinnitus assessments 
7. Provide general guidelines for implementing results into tinnitus sound therapies 

provided by leading hearing aid manufacturers 
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Performing the Tinnometer Testing: 

 
 

• Click the Tinnometer button from 
the main Avant Audiometer main 
screen. 

The following screenshot shows the key features of the Tinnometer: 
 

1. Toggle Switch to Start/Stop stimulus 
2. Sliders to control frequency, 

bandwidth, slope and tempo of the 
stimulus 

3. Slider to control the intensity of the 
stimulus 

4. Buttons used in determining tinnitus 
match, threshold and minimum 
masking level 

5. Area where description of items will 
be displayed 

6. Channels designed to present 
multiple types of tinnitus sounds 

 
7. A graphical display of the sounds being played for the patient. Stimulus and 

Audiogram (if done within Avant or Noah) are display in dB SPL 
 

 
 
 
Interactions with the patient are controlled as follows: 

 
1. Patient response switch indicator 
2. Patient monitor microphone 
3. Talk forward 

4. Undo 
5. Toggle help section 
6. Return to Avant 



D-0117971-C  05/2019 23                                                                                                            

 
There are 3 Steps needed for Tinnitus Assessment with the Tinnometer 

1. Identify patient’s tinnitus by frequency, bandwidth, slope and tempo 
2. Lower the identified tinnitus until patient threshold is reached 
3. Raise the tinnitus level above the identified tinnitus intensity (widen bandwidth if 

needed) until the patient states they no longer hear the tinnitus. Play stimulus for 60 
seconds to ensure masking is achieved. 

 
Step 1: Identify Patient’s Tinnitus 
 

 
 
 

1. Start by selecting the tinnitus type 
that has been described by the 
patient. This is an approximation of 
the tinnitus sound your patient hears. 
Tinnitus type will provide a starting 
frequency, bandwidth and slope to 
help speed up testing time. 

 

 
 

 
 

2. Use the stimulus start/stop toggle to 
present the selected signal to the 
patient. 

 
3. Use frequency slider to match the 

pitch of the patient’s perceived 
tinnitus 

4. Use volume slider to match patient’s 
perceived intensity of tinnitus 

5. Adjust bandwidth, slope and tempo 
(for pulsating tinnitus or prevention of 
adaptation) as needed 

6. Buttons to allow greater flexibility in 
bandwidth and slope of tinnitus. 
Allows the addition of high/low 
frequency sounds independently 

7. Allows for independent right/left 
volume control 

8. Press Tinnitus Level button once the 
patient’s tinnitus is matched 
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Step 2: Find Identified Tinnitus Threshold 
 

 

1. Use down arrow on your keyboard to 
lower stimulus until patient states 
they are no longer able to hear the 
tinnitus.  
 

2. Click Threshold Level button. 
Step 3: Masking Tinnitus for 60 Seconds 
 

 
 

1. Use volume slider to increase 
intensity of the stimulus until the 
patient states they are no longer able 
to hear their tinnitus. 
 
NOTE: Lower levels of masking may be 
achieved by increasing bandwidth of 
the masking stimulus. Pulsating the 
masking noise can prevent tinnitus 
adaptation. 
 

 

2. Press the MML button and continue 
presenting stimulus until 60 second 
countdown ends. 
 

3. If patient begins to hear their tinnitus 
within the 60 seconds, raise intensity 
until masking is achieved and repeat 
number 2. 

Tinnometer Modulation Tab 
 
The Tinnometer modulation tab is designed to simulate sound generators when 
hearing aid demonstrations cannot be performed. The following are controls 
used in Modulation. 
 

 
 

1. Type of modulation Sound 3. Frequency of modulation 
2. Speed of modulation 4. Modulation volume range 
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To use the Modulation features within Tinnometer, you must first complete the 
three steps involved with tinnitus assessment. Once tinnitus assessment is 
complete, you can use modulation by: 
 

 
 

1. Activating the channel in 
which the tinnitus 
assessment was 
performed. 

 
 

2. Enter the modulation tab 
on the right side of 
Tinnometer software. 

 
3. Adjust the modulation stimulus with sliders as a counseling tool for the 

patient. 
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Tinnometer Audiometry Scan 
 
The Tinnometer Scan tab is designed for various forms of air conduction 
audiometry. There are three types of audiometry that can be performed with 
Tinnometer. You can access the forms of audiometry with the buttons located 
by the number 1 in the image below. 
 

  
 
Tinnometer Residual Inhibition (RI) 
 
The Tinnometer RI tab is designed for Residual Inhibition (RI) testing for a 
patient’s tinnitus. The controls in the RI tab are as follows: 
 

 

1. Scale from 0-10 of 
tinnitus bothersome 
level 

2. Timer to begin 
stimulus 

3. Tracking of patient’s 
tinnitus bothersome 
level as a function of 
time 

 
A complete tinnitus assessment must be performed prior to performing testing 
in the RI tab. Once tinnitus assessment testing is completed, optional residual 
inhibition testing can be performed with the following steps: 
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1. Activating the channel in 
which the tinnitus 
assessment was performed. 

 
 

2. Select the RI tab on the 
right side of the Tinnometer 
software. 

 
 

3. Ask the patient the 
bothersome level of their 
tinnitus from 1 to 10 and 
mark their response. 

 
 

4. Click the stop watch to 
begin the masking stimulus 
(stimulus to play for 60 
seconds). 

 
5. Stimulus will play for 60 seconds and automatically stop at the 60 second 

point. 
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6. When the stimulus stops the patient must redefine their tinnitus 

bothersome level every 30 seconds. The bothersome level should 
decrease upon the stimulus stopping and will increase with time. 
  

7. The test continues until the bothersome level returns to pre-test level. 
 
Tinnometer Report Printing 
 
The Tinnometer has four reports available for printing: tinnitus assessment 
report, manufacturer guidance report, questionnaire report and a channel 
report. 
 
The following are common features found across reports: 
 

 
 

1. To generate your report, 
select “printer …” from 
the File menu. 

 
 

2. Select the paper style 
you are printing. 

 
 

3. Confirm all patient 
information is correct. 

 
 

4. Choose your print 
preferences. 

 
 

5. Change the zoom of your 
print preview. 
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6. Print your Report. 

 
Tinnitus Assessment Report 
 
Tinnitus assessment reports are able to be generated after completing the 
three steps to tinnitus assessment. Once all steps are complete you are able to 
print a report  
 

 
 

1. To generate your tinnitus 
assessment report, select 
“printer …” from the File menu. 

 
 

2. The “Channel” reports are the 
tinnitus assessment reports. 
Select the channel used for 
testing or All Channels when 
multi-channel testing is 
completed. 

 
 

3. Use the drop down box to 
select a diagnosis for the 
patient. 
 
 

 
 

4. Comments can be entered in 4 
separate lines with a maximum 
of 60 characters. 

 

5. Print the Report. 
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Manufacturer Guidance Report 
 
Manufacturer guidance reports are designed to provide hearing aid sound 
therapy guidance to a clinician based on tinnitus assessment results. Sound 
therapy is an option to tinnitus treatment. We encourage all clinics to develop 
a tinnitus treatment protocol that is in line with their tinnitus treatment goals. 
Manufacturer guidance generated by the Tinnometer is designed to be a 
starting point in sound therapy and each patient may differ in preferred sound. 
 
Manufacturer guidance reports are able to be generated after completing the 
three steps to tinnitus assessment. Once all three tinnitus assessment steps 
are complete you are able to print a report. 
 

 
 

1. Select the manufacturer that  
you would like to have printed 
in your report. 

 
 

2. To generate your tinnitus 
assessment report, select 
“printer …” from the File menu. 

 
 

3. Select “Hearing Aid Guidance” 
from the list of reports. 

 
 

4. Use the drop down box to 
select a diagnosis for the 
patient. 
 

 
 

5. Comments can be entered in 4 
separate lines with a maximum 
of 60 characters. 
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6. Print the report. 

 
Graph Channel Report 
 
Graph channel reports will print a patient report which displays an image of the 
patient’s tinnitus with QR codes for YouTube videos that play a wind 
modulation noise nearest to their tinnitus. To generate the report you must: 
 

 
 

1. To generate your tinnitus 
assessment report, select 
“printer …” from the File menu. 

 
 

2. Select “Graph Channel” from 
the list of reports.  Select the 
channel number which you 
used to match your patient’s 
tinnitus sound. 

 

3. Print the report. 

 
Questionnaire Report 
 
Questionnaire reports will only show as an option once the questionnaire has 
been completed. Once a questionnaire has been completed and you are ready 
to print a report you must: 
 

 
 

1. To generate your tinnitus 
assessment report, select 
“printer …” from the File menu. 
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2. Select the name of the 
questionnaire you want to print 
from the list of reports.  

 

3. Print the report. 

Hearing Loss Simulator 
The Hearing Loss Simulator (HLS) demonstrates the effect of the client’s hearing loss for 
the significant third party. The program attenuates an input signal to simulate the 
audiogram. The third party listens to the free field speakers.  The third party can hear how 
their own voice is distorted by the hearing loss when the Record input option is used. 
 

The Hearing Loss Simulator requires the client’s Audiogram data. This data can be 
manually entered in the Audio screen of this or any other task. 

How to perform the Hearing Loss Simulator task  

• Select the HLS tab on the toolbar.  
 

• Enter the Audiogram values manually if the data is not automatically imported to this 
screen.  
 

• Select the input signal type: Mic, File or Record. Select the track and the Play button on 
the control panel. See below for instructions on how to use the Record option.  
 

• The HLS output is directed to the free field loudspeakers.   
 

• Select Normal to play the input signal as a person with normal hearing would perceive 
it. Select Simulated to turn on the simulation of the client's hearing loss. Toggle 
between these selections as necessary.  

• The Reset option restores the audiogram to the original state. Use this option if you 
have modified the audiogram but want to undo the changes. The changes to the 
Audiogram that are made on the HLS screen are temporary and will not affect the client's 
original audiometry record. 

• A volume control adjustment bar allows for manual adjustment of the output level of the 
free field speakers. 
 

• To stop the playback, select the Stop button on the player.  

NOTE: It is recommended you use a variety of tracks from the list to demonstrate the hearing 
loss. 

Record Input Option 
This option allows recording and playing back of the voice of the third party. 



D-0117971-C  05/2019 33                                                                                                            

Master Hearing Aid 
Master Hearing Aid (MHA) is an alternative to using a stock hearing aid to demonstrate the 
benefits of amplification to an inexperienced user. The system applies the fitting rules by default 
to the patient's audiogram and simulates a hearing aid. The patient listens to this signal through 
the headphones. Options for editing the gain applied to the audiogram are provided. 
About the Master Hearing Aid Display 

The Master Hearing Aid screen displays a graph with dB Gain on the vertical axis and Frequency 
in Hz on the horizontal axis. The plot on the graph represents the gain applied to the patient’s 
Audiogram. The NAL-RP is applied by default. A new rule can be selected from the list on the 
right side of the display. A volume adjustment bar allows for manual adjustment of the output 
level. The control panel on the right of the display provides options for input signal source and 
the task icons for Normal and Simulate.  

The Master Hearing Aid applies gain separately for each ear.  If audiogram values are entered for 
the left and right ear, the selected fitting rules will be applied to each ear separately. Different 
rules may be entered for different ears (i.e. NAL-RP for left ear and BERGER for right ear). If an 
audiogram is entered only for one ear, the gain will not be adjusted for the opposite ear and the 
sound for that ear will be normal.  

If Binaural mode is selected, the sound will be heard from both channels (left and right). If 
Monaural mode is selected, the sound will be heard only from the channel corresponding to 
the active ear when the channel for the opposite ear will be muted. 

Input signal 

Live voice (microphone) allows you to use the talk-over microphone for live speech input to 
the inserts.  The clinician or significant third party can speak into the microphone for this activity. 
Note: there is a processing delay between the input and playback. Make sure that the client 
cannot hear the voice directly but only through the headset. If this is not possible, use the 
Recorder (describer below) to simulate speech input. 

File allows the user to play sound files. The program supports MP3 and WAV files and comes 
with pre-set MedRx Sounds Sensations sound files. After the option is activated, use the player 
panel to control the playback. 

CD allows the user to play music CDs. After the option is activated, use the player panel to 
control the playback. 

Record input mode allows the clinician or third party to record a sample of their speech which 
can then be replayed for repeat comparisons under different amplification conditions for the 
patient. Refer to the interactive Help system by pressing F1 or clicking the Help icon to learn 
more about the recorder. 
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How to use the Master Hearing Aid:  

1. Select the Master Hearing Aid (MHA) icon from the main screen.  
 

2. Enter the Audiogram values manually if the data is not automatically imported to this 
screen.   
 

3. Select the input signal type: File, CD, Mic, or Record.  
 

4. Select Monaural or Binaural. 
 

5. Select the Normal icon, which will send the input signal through to the inserts without 
modification. The patient is listening to the signal without any amplification benefit. 
Select the Simulate icon to modify the input signal according to the selected rule. This 
selection allows the patient to hear the benefits of amplification. Toggle between these 
two selections as necessary.  
 

6. If the simulated frequency response needs to be adjusted, based on feedback from the 
patient, manually edit the response by clicking on the gain curve at the desired 
frequency and new gain level.  The gain curve of the selected test ear on the control 
panel can be edited.  To edit the other ear, click the appropriate test ear icon on the 
control panel first.  

Hint: Use the track return icon on the player control panel to replay one track continuously. 

  
 
The Reset option restores the rule to the original state. Use this option if you have modified the 
rule but want to undo the changes.  

 

Preparing for Real Ear Measurement Testing 

Loudspeaker Output Selection  

There are two possible loudspeaker selections. Either the Line Out selection that uses powered 
speakers as shown on the following pages or the internal amplified speaker output (Red and 
Blue connectors) can be used with passive speakers. Go to the Tools menu and select the 
speaker selection you want. A check mark will be shown next to the selection. Refer to the 
speaker wire installation method under “To Install Free Field Speaker Wires” seen below.                                                            
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Open the Speaker Calibration screen from REM/LSM screen menu Tools > Calibrate 
Speakers. 
 

 

The speaker should be positioned in such a way that nothing blocks the path of the emanated 
sound in front and on the sides of the speaker. For example, positioning a speaker behind a 
monitor is incorrect and can severely affect its response at the measurement location. The 
speaker diaphragm should be at about the same level as the patient's ear and the reference 
microphone. 

Place the reference microphone at the location where the patient normally sits, or about 1 meter 
from the speakers.  

Click on Start to begin the calibration and wait until it ends. Observe the response curve flatten 
itself out. The darker curve is showing the response used by the equalization algorithm, the 
lighter curve is showing the current microphone input. Use of the powered speaker supplied 
with this device is recommended. 

 

  

Speaker Calibration 
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Positioning the Speakers 

Proper positioning of 
the loudspeakers 
relative to the patient’s 
hearing instruments is 
critical for making 
accurate and repeatable 
measurements. Seat the 
patient so their ear is 
between 19 and 39 
inches from the 
loudspeaker.   

 

Make sure the grill of the loudspeaker is level with and directly in front of the patient’s head. 

When using Live Speech inputs, position the patient so the mouth of the person speaking is in the 
same position as the loudspeaker shown here. 

 

Calibrating the Probe Tube    

For reasons of infection control and reliability of results, MedRx recommends that a new probe 
tube be used with each patient.  To ensure accurate measurements, it is necessary to calibrate 
the probe tube each time it is replaced. 
 

 

1. Place a new probe tube on the 
probe microphone port as 
shown. 
 

2. Place the probe tube between 
the calibration nibs as shown.  
Be sure that the opening of the 
probe tube is centered on the 
opening of the reference 
microphone.  
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In the Avant REM - Avant ARC software, do one of the following: 
• Click the 

Probe Tube 
Calibration 
Icon.  

    or 

• Click Tools. 
• Click Calibrate 

Probe Tube. 

 

 
Position probe microphone with 
probe tube in calibration position 
between 19 and 39 inches from the 
loudspeaker and Click Start. The 
signal must be at least 70 dB to 
complete a valid calibration.  If the 
screen prompt indicates the signal is 
too low, increase the volume on the 
loudspeaker or move the probe 
microphone assembly closer and re-
start the calibration. The system will 
calibrate and stop on its own. 

Repeat for the other probe. Valid 
calibrations have the same 
approximate shape as the gray target 
curve.  If the measured calibration 
curve differs greatly in shape or 
amplitude from the gray target curve, 
replace the probe tube and re-
calibrate.  If this does not correct the 
problem, contact MedRx technical 
support at (888) 392-1234. 

 

The calibration date is available from the AVANT ARC main screen under the  
Function > Calibrate > Calibration Information tabs.  
Return Probe Microphones to MedRx for annual re-calibration. Annual re-calibration of the 
Avant ARC Probe Microphones is recommended.  There are no user repairable components of 
this device.  
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Live Speech Mapping  
Step-by-Step Guide to Live Speech Mapping 
 
Ensure the Audiogram is Entered 
 
Before making Live Speech Mapping measurements, the patient’s pure tone audiogram must be 
available to the software.  This can occur several ways: 

1. The audiogram was automatically entered by MedRx AVANT Audiometer software when 
testing. Then saving the NOAH session. 

2. The audiogram was manually entered into the NOAH software and saved. 
3. The audiogram was entered using another manufacturer’s audiogram module and saved 

in NOAH. 
 
If none of these have occurred, you may manually enter the audiometric data into the Avant 
REM - Avant ARC software as follows: 
 

 
 

 

1. Launch the audiometric module by 
clicking on the Audio button on the 
right side of the AVANT main 
window. 

2. Using your mouse, select the test ear.  
3. Select the test type Air. 
4. Enter thresholds by clicking the 

intersection points with the mouse. 
(You may also enter the audiogram by 
selecting the audio tab in either the 
LSM or HLS/MHA screens). 

5. Repeat for UCL (Bone and MCL 
optional). 

6. Repeat steps 3-5 for the other ear. 
 
After the audiogram as entered, click the Back button to return to the AVANT Main screen. 
 

 

1. From the AVANT Main screen, click LSM. 
 

       

2. In the next Window, click LSM again. 

 
The Operator Headphone is used by the operator to monitor the signal being received by the 
probe microphone. 
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The screen shot below provides an overview of all the tools and controls on the Live Speech 
Mapping screen. For more information on these features, please consult the Interactive Help 
system by pressing the F1 key or clicking the Help icon. 
 

 
 
 

1. Sound level meter 
2. Ear selection 
3. Measurement type 

• Peaks 
• LTAS  

4. Input Selector 
 

5. Open Fit Function 
6. Reset Button 
7. Test Interrupter 
8. Discard, Help and Back buttons 
9. Legend 

10. Target area – can be any of the 
following: 
• MedRx Modified Speech Spectrum 
• DSL IO 
• NAL-NL2 
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Speech Mapping with Live Voice Inputs 

 

The screenshot on the left shows the Live 
Speech Mapping (LSM) window.  The 
system is designed to capture and display 
the human voice in the ear canal, so it is 
recommend to use the microphone input 
and the peaks measurement. 
 
Using the microphone allows 
measurement of both the professional’s 
voice and that of the patient’s significant 
other. 
 
To improve repeatability of measurements, 
it is recommended that the speaker read a 
standard passage such as the “Rainbow 
Passage” which is provided on pg. 31. 

NOTE: The screen shot above shows the MedRx Modified Speech Spectrum (Canoe).  It is also 
possible to underlay DSL IO or NAL-NL2 targets on this screen. Click Options in the text menu bar on 
the top of the screen to select and configure these underlays to meet the needs of your practice. 
 

Speech Mapping with Recorded Inputs 
 

 

For those who prefer a recorded, 
repeatable stimulus for Speech Mapping, 
the software provides several digital audio 
files. These are accessed by clicking the 
File button on the right and then selecting 
the desired track from the pull-down 
menu in the audio player. Peak 
measurements is recommended. 
 
Once the desired track is selected, click the 
Start button to begin measuring. A pure 
tone or white noise will be presented and 
once it reaches the selected input level 
with the slide bar, the chosen track will 
play. When enough data is collected, click 
the Stop button to stop the recording and 
capture the measurement. 
 

It is also possible to use an audio CD, such as the patient’s favorite music to perform Speech 
Mapping.  Simply click the CD button and then select a track as above. Use the sound level 
meter on screen to check the proper level. Adjust the output of the speaker to desired level 
using the sound level meter. (Remember conversational speech is 65 dB SPL at 1 meter). 

NOTE: The screen shot above shows the MedRx Modified Speech Spectrum (Canoe). It is also 
possible to underlay DSL IO or NAL-NL2 targets on this screen. Click Options + Show Targets in the 
text menu bar on the top of the screen to select and configure these underlays to meet the needs of your 
practice. 
 

 



D-0117971-C  05/2019 41                                                                                                            

Running Speech Mapping “On-Top” within NOAH 
 
It is well established that verifying the output of hearing instruments in the patient’s ear will 
improve the accuracy of the fitting. In the past, it has been difficult to verify these fittings since 
many real ear systems have been disconnected from the fitting system. The AVANT ARC system 
is tightly integrated with NOAH, the industry standard for audiometric and fitting data storage 
and retrieval. The “on-top” mode of the Avant REM - Avant ARC software allows you to 
effortlessly alternate between measurement and fitting adjustments. 
 

 

 
 

 
From the Avant ARC main screen, click the NOAH LSM button.  
 
The Avant REM - Avant ARC window will reduce in size and float  
“on top” of the NOAH screen. 
 
Open the fitting module from the NOAH Module Selection 
Screen. 

 Use the text menus and green (start) and red (stop) buttons in 
the floating LSM window to make Speech Mapping 
measurements.   
 
Make necessary changes to the instrument based on these 
measurements.  
 
To make adjustments to the hearing instrument, click on the 
fitting module window and modify the settings according to the 
manufacturer’s instructions, being sure to activate, apply or save 
the settings to the instrument. 
 
Repeat this measure/adjust/measure cycle until the fitting is 
optimized. 

  
Completing the On-Top Mode Process  
 
Close the REM module by clicking the X button and select the Exit icon. Save the NOAH session 
when prompted.  
 
 
 
 
 
 
 
 
 
 
 
 
 



42  D-0117971-C  05/2019 

MedRx Live Speech Mapping Protocol  
Unlike other products, the AVANT ARC system places full control over the measurement environment firmly 
in the hands of the hearing care professional. The system is powerful, yet extremely flexible, allowing each 
provider to use Live Speech Mapping in a way that compliments their practice style rather than 
compromising it. 
 

In order to get you “up and running” with the AVANT ARC system, MedRx has developed the following 
protocol. This simple procedure has been found to be effective with both audiologists and hearing instrument 
specialists. After mastering the basic operation of the system utilized in this protocol, you are encouraged to 
further expand your use of Live Speech Mapping in your practice. Feature-specific help is available by simply 
pressing the F1 key or clicking on the Help icon or text menu. 
     

1. Complete a careful otoscopic examination as instructed by the 
manufacturer of your otoscope. 

• For MedRx Video Otoscopes, refer to the Help system within the 
software by pressing the F1 key or clicking the Help icon or text 
menu. 
 

2. Basic Diagnostics. 
a. Using your audiometer and NOAH, measure and record the 

following values: 
b. Pure Tone Air and Bone conduction thresholds. 
c. Narrow Band Noise or Pure Tone UCL at 500, 1000, 2000 and 

4000 Hz. 
d. Other tests if needed in your practice or jurisdiction. 

 
3. Position patient as described earlier in this manual. 

 
4. Calibrate Probe Tube as described earlier in this manual. 
5. Measure and place the probe tube in the ear canal. (Use guide to the 

right). 
6. Complete a Live Speech Mapping measurement UNAIDED. 

a. Microphone input. 
b. Peak Measures. 
c. 1/3 Octave resolution. 

 
7. Carefully place the hearing instrument in the ear without disturbing the 

probe tube. 
 

8. Complete a Live Speech Mapping measurement AIDED. 
 

9. Using the On Top Mode, make any adjustments needed to the hearing 
instrument so that: 

a. The LSM curve for Quiet Speech (50 dB) is at the bottom of the 
white modified speech spectrum (canoe). 

b. The LSM curve for Conversational Speech (65 dB) should be 
within the white modified speech spectrum. 

c. The LSM curve for loud sounds (85 dB) (very loud speech, 
clapping hands, etc.) is approximately 10 dB below the UCL 
curve. 

 

 

  
 

Probe Tube Insertion 
Guide 

for Live Speech Mapping 
and Conventional REM 

(re: Pomford, J & Sinclair, S. Real-Ear Measurement: 
Basic Terminology and Procedures. Audiology OnLine.com) 

 

 
     (Adult) 

 
    (Adult) 

 

 
 
1. Perform Otoscopic Examination 
2. Align end of Probe Tube with 
the 

left end of the appropriate 
guide 

3. Align tube marker with the red 
marker above 

4. Place Probe Tube in ear canal 
5. Confirm placement with 
Otoscope 
6. Perform Live Speech Mapping 
& REM 
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Rainbow Passage 
 

When the sunlight strikes raindrops in the air, 

they act like a prism and form a rainbow. The 

rainbow is a division of white light into many 

beautiful colors. These take the shape of a long 

round arch, with its path high above and its two 

ends apparently beyond the horizon. There is, 

according to legend, a boiling pot of gold at one 

end. People look, but no one ever finds it. When 

a man looks for something beyond his reach, his 

friends say he is looking for the pot of gold at the 

end of the rainbow. 
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Real Ear Measurements 
 
In addition to Live Speech Mapping, the Avant ARC supports all conventional Real Ear 
Measurements (REM).  All of these tests are accessed from the main Avant ARC-REM screen. 
 

To begin, click 
the   

button on the right of the Avant main screen. 

   

In general, REM tasks are performed as follows: 
 

 

 
 
 

1. Select the REM test you wish to perform from the top row of buttons. 
2. Select the test ear.  
3. Select the test stimulus. 
4. Click Start.  The test will stop itself after sufficient data has been collected. 
5. If you wish to delete a curve, simply select it with your mouse (left click) and then click the 

Discard icon or press the Delete key. 
6. When all measurements are complete, click the Back arrow to return to the AVANT Main 

Screen. 
 

 
Descriptions of the various “Stimulus” options are presented in the Help files under the topic 
“Signal Types”. Access these by clicking on the “Help” tab at the top of the screen, and selecting 
“Help Topics”. Select an item from the list in the Index tab, and click “Display”. 
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Stimulus Signal Types 
 
Pure Tone 
 A pure sine wave. Crest Factor = 1.41 (3.0dB) 
  
Broadband Noise (BBN) 
 Uniform random noise with normal (Gaussian) amplitude distribution. Can be weighted to White, Pink, Speech ANSI, and Speech 
Byrne (see below.) 
  
Pseudo Random Noise (PRN) 
 A "synthetic" broadband random noise. It is less uniform than BBN, has lower spectral density and random volleys. Can be weigted to 
White, Pink, Speech ANSI, and Speech Byrne (see below.) 
  
ICRA Noise 
 This stimulus was developed for measuring characteristics of non-linear instruments. The noise is weighted to Byrne LTASS. 
  
ISTS 
(International Speech Test Signal) 
 Initiated by European Hearing Instrument Manufacturing Association (EHIMA.) This signal is based on natural recordings of 21 female 
speakers in six different languages - American English, Arabic, Chinese, French, German and Spanish. The signal is largely non-
intelligible because of segmentation and remixing. The speech material was filtered to Byrne LTASS. 
 
Crest Factor: 9.23 (19.3dB) 
 
  
Rainbow Passage 
 Natural recordings of several voices reciting the rainbow passage. Shaped to Byrne LTASS.  
 
  
Broadband Noise Weighting 
 
White 
 This is essentially no weighting or filtering. The White Noise has flat power spectral density. Power at every frequency is equal. 
Because the density of frequencies (individual cycles) raises with frequency, there is more energy in high octaves.  
White-weighted noise can be used mostly for testing of equipment. It is not recommended to use it for hearing aid fitting, unless 
specified by the manufacturer. 
 
Crest Factor: BBN = 1.73 (4.8dB), PRN = 7.86 (17.9dB) 
 
Pink 
 The noise is filtered so its energy per frequency (power spectral density) is inversely proportional to the frequency. Each octave carries 
the same amount of energy. Comparing to White Noise, the Pink Noise energy drops approximately 3dB per octave. 
Pink-weighted noise can be used mostly for testing of equipment. It is not recommended to use it for hearing aid fitting, unless specified 
by the manufacturer. 
 
Crest Factor: BBN = 3.67 (11.3dB), PRN = 6.55 (16.3dB) 
 
Speech - Byrne 
 The noise is approximately weighted to International Long Terms Average Speech Spectrum (ILTASS) as described in Byrne et. al., 
1994.  
The noise with this weighting is preferred for hearing aid fitting because its spectrum is the best approximation of the spectrum of real 
human speech. 
 
Crest Factor: BBN = 4.22 (12.5dB), PRN = 3.47 (10.8dB) 
 
Speech - ANSI 
 The noise is approximately weighted to ANSI S3.42 Speech Noise. 
The noise with this weighting can be used for fitting hearing aids. The slope of ANSI-weighted noise is not as steep as Byrne-weighted, 
so there is more power in higher octaves.  This will result in less gain required by the hearing aid to reach targets, but may result in 
under-fitting at high frequencies. 
 
Crest Factor: BBN = 4.46 (13.0dB), PRN = 5.17 (14.3dB) 
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To activate specific REM tests, click the buttons as follows: 
 
 

 

Opens the audiometry data entry screen.  Use this if audiometry has not been previously 
measured and entered into NOAH. 

 

Allows the selection of fitting rules to generate targets.  The following rules are supported: 
½ Gain, POGO I, POGO II, Berger, 1/3 Gain, NAL-RP, FIG6, DSL, NAL-NL1. 

 

Real Ear Unaided Response - Measures the additive effect of the ear canal’s resonance 
to a stimulus.  Reported as dB SPL of output. 

 

Real Ear Unaided Gain - Measures the additive effect of the ear canal’s resonance to a 
stimulus.  Reported as dB SPL of gain.  If a real ear unaided response (REUR) curve has 
been measured, the corresponding real ear unaided gain curve is automatically plotted to 
the REUG screen. 

 

The difference between the REUG and the REAG is called the Real Ear Insertion Gain 
(REIG). This Insertion Gain information is used to compare to the target gain curve 
selected for the client. 

 

The Real Ear Aided Response (REAR) is the sound pressure level in the ear canal 
measured with the probe microphone close to the eardrum and the operating hearing 
instrument inserted in the ear and turned on. ANSI defines REAR as the SPL, as a 
function of frequency, at a specified measurement point in the ear canal for a specified 
sound field, with the hearing aid in place and turned on. 

 

The REAG is simply the REAR expressed as gain rather than SPL. Selecting REAG 
allows you to see the gain at each frequency for each of the REAR curves measured. 

 

REOR measures the effect on the natural external ear effects resulting from inserting an 
ear mold or a hearing instrument, before it is turned on, into the ear canal. The REOR is 
also referred to as Insertion Loss. REOR is also useful for validating the effectiveness of 
venting or canal length changes to the mold.  

 

The Real Ear Occluded Gain (REOG) is the difference in decibels, as a function of 
frequency, between SPL in the ear canal and SPL at the reference microphone at the 
entrance of the ear canal with the hearing aid in the ear and turned off. For each REOR 
measurement curve, the corresponding REOG curve is calculated and automatically 
plotted to the REOG screen. The REOG function is useful in determining the acoustic seal 
of a hearing aid, relative to a sound field outside the ear. 

 

Some clients report they seem like they are “speaking in a barrel” or “feel blocked up”. 
These are signs of a build up of self generated low frequency energy in the ear canal. This 
excessive occlusion can be measured objectively in the Occlusion Effect task. 

 

The Real Ear to Coupler Difference (RECD) is used to simulate real ear measurements by 
coupler measurements and is useful when fitting children or “difficult” to fit patients.  See 
the section on RECD later in this manual for more detail. 
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Additional Tests & Features 
 
Real Ear to Coupler Difference (RECD) 

The Real Ear to Coupler Difference (RECD) is used to simulate real ear measurements by coupler 
measurements and is useful when fitting children or difficult to fit patients.  RECD measurements 
can be conducted outside of a Hearing Instrument Test Box when using the optional MedRx 
RECD Coupler.  

 
The RECD values are used as a correction to coupler measures for that client’s hearing 
instruments. By performing all subsequent measures in the coupler and applying the RECD 
corrections to the coupler measures, the “real ear” factors are incorporated into the results. The 
resulting simulated measurements provide information to select and make adjustments to the 
hearing instrument and verify adjustments in the MedRx coupler rather than in the 
uncooperative client’s ear. This is particularly important in the case of children, whose small 
volume ear canals enhance high frequency amplification more so than in average adults. This is 
an essential consideration in determining the maximum output of the hearing instrument. 

If RECD data is present, the software will display an option to choose between Ear or Coupler 
measurement on all Real Ear screens where measurements in a coupler are appropriate. 

There are two ways to measure the REAR response with optional RECD coupler: using an insert 
headphone or a hearing instrument. 

If a hearing instrument is used, its volume control setting and other parameters should remain 
the same for both REAR and coupler measurements. Set the volume control to moderate, and 
turn the compression and noise reduction circuits off. 

Using open-fit hearing aids for RECD measurements may result in invalid low and mid-frequency 
measurements because of insufficient gain at those frequencies.  Please contact your hearing aid 
manufacturer for recommendations. 
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How to perform the RECD task 
 
First, perform the REAR task to obtain an REAR curve.  This can be measured with a hearing 
instrument or an insert earphone. 

REAR with a hearing instrument 

 

• Adjust volume of the hearing instrument to comfortable 
listening level. Turn the compression and noise reduction 
circuits off.  

• Position the client less than one meter from the speaker and 
facing the speaker.  

• Place the hearing instrument and the probe microphone tube 
as for all REM measurements.  

• Select START to open the measurement type selection screen.  

• Choose the REAR with a Hearing Aid option.  
• Select OK to begin the test and wait until it concludes. 

 

 

REAR with an insert headphone 

 

• Place the probe microphone tube as for all REM 
measurements but use the insert headphone instead of a 
hearing instrument. 

• Select START to open the measurement type selection screen.  

 
• Choose the REAR with an Insert Headphone option.  

 
• Select OK to begin the test and wait until it concludes.  
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Coupler Response 

When the REAR is complete, you are prompted to perform a coupler response. 
 

 

• Attach the hearing instrument or the insert headphone (must 
be the same as used in the REAR test) to the appropriate 
coupler and place the probe tube inside the coupler.  

• If a hearing instrument is used, be sure to perform this 
measurement at the same volume control setting as the first 
measurement.  

• Select START to open the measurement type selection 
screen.  

 

• Choose the Coupler Response option or Use Stored to 
skip the measurement (see note below.)  

• Select OK and wait until the test completes.  

• The calculated RECD curve is automatically displayed on the 
screen and is stored in memory for correction of subsequent 
coupler measurements made from the RECD function.  

Note: If the REAR and the coupler response were measured with the insert headphone, 
the program saves the coupler response curve for later use. In this case to obtain another 
RECD, only REAR with insert headphone measurement is necessary. This is possible because 
the coupler response does not change provided that neither the coupler nor the insert 
earphone has changed. 

Note: After measuring RECD, it is possible to perform Live Speech Mapping in the 
coupler as well. Look for the “Measuring in” option on the LSM screen. 
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Measuring Acoustic Feedback 
Feedback (whistling, howling) is one of the most common complaints of hearing instrument 
users.  Even though many modern hearing instruments have sophisticated feedback 
management systems, knowing exactly where the feedback is occurring can greatly reduce the 
time required to resolve the problem.  The AVANT ARC system does an excellent job measuring 
and displaying acoustic feedback. 
 

 

1. Place the calibrated probe tube in the ear canal as 
instructed previously. 

2. Place the hearing instrument in the ear without 
disturbing the probe tube. 

3. Begin a Live Speech Mapping session as 
instructed previously. 

4. When feedback is present, click the Start button. 
5. Acoustic feedback appears as a large spike in the 

LSM response. 

 

If a more specific frequency analysis of the 
feedback is desired, change the resolution of the 
system to 1/24 octave by clicking the Options 
menu item and changing the Analyzer selection 
using the pull-down menu.  This image shows the 
same feedback as above at 1/24 octave. 
 
Using this information, make any necessary 
adjustments to the hearing instrument to reduce 
or remove the feedback. 
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Printing 
 
Printing within the Avant ARC software is very simple. 

 

 

From the File menu, click one of the following options: 

Page Setup – Allows you to set margin sizes and the 
default text header for your reports. 

Print Setup – selects the printer you want the report to 
be sent to.   

Print Preview – Shows you what your report will look 
like before you print it. 

Print – Sends the report to the printer.  This option 
opens the Windows Print dialog which allows the user 
to select any installed printer and modify the 
properties (quality, number of copies, etc.) for the print 
job. 

 
 

Device Maintenance 
Annual re-calibration of the transducers used with the Avant ARC is recommended. There are no 
user repairable components of this device. 

Refer to the Installation Manual for care and cleaning instructions. 

Customer supplied components of this Medical Electrical system should be cleaned and 
maintained according to their manufacturer’s instructions. (laptops, amplifiers, etc.) 
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Symbols that may be used:  
 

 

 
 or SN 

 
 

 
 

 

 

Read the instruction 
manuals for safe usage of 

the device  
(operating instructions) 

 Indicates that the device 
serial number will follow 

 

 Type B applied part.  (Type B 
equipment) 

 Manufacturer 
(MedRx) 

 Authorized 
Representative in 

Europe 

 

 

 

 

 

 

 

 

 

Non-ionizing 
electromagnetic radiation 

 Special Disposal Required  Humidity Limitation  Caution, General 
warning sign 

 Temperature 
limitation 

 

 

 

 

 

 

 

 

 

Read the instruction 
manuals for safe usage of 

the device  
(operating instructions) 

 Class II equipment  Start (of action)  Stop (of action)  Percentile Setup 

 

 

 

 

 

 

 

 

 

Calibration  Loudspeaker (Speaker)  Headphones  Microphone  Recording 

 

        

CAUTION 
For Single Patient Use 

Only 

      

 

  

 

 The date of manufacture is shown on the original calibration certificate. The year of manufacture is 
shown in the fourth character in the serial number. M=2014, N=2015, P=2016, Q=2017 etc. 
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Limited Warranty 
MedRx, Inc warrants this product to be free from defects in material and 
workmanship for one year from the time of purchase. If this system fails to 
perform as specified during this period, the purchaser is responsible for 
calling MedRx at (888) 392-1234 or (727) 584-9600. The company's represen-
tative will advise the owner to either return specific components or the entire 
system to:  

MedRx, Inc. 
1200 Starkey Road #105 

Largo, FL 33771 USA 

MedRx will repair or replace any defective devices, fully test the system 
and/or components and ship the system promptly back to the owner. There is 
no cost for the repair or return shipping, provided the system is one year old 
or less and has not been misused, abused or damaged. Such damage 
includes, but is not limited to, dropping, exposure to excessive heat greater 
than 100ºF and water/liquid damage.  

Repair or replacement of the system as provided under this warranty is the 
sole and exclusive remedy of the purchaser. MedRx shall not be liable for any 
consequential or incidental damages or for breach of any express or implied 
warranty. Except to the extent of applicable law, any implied warranty, 
merchantability or fitness of this product is limited to the duration of this 
warranty.  

MedRx will, at its discretion, service and repair out of warranty products at the 
purchaser's request, charging for parts and labor as necessary.  

The limited warranty is deemed void if software or hardware is installed on 
this product which is not pre-approved by MedRx, Inc. Approved software 
includes NOAH™ and HIMSA approved hearing aid manufacturer 
programming modules for fitting hearing aids.  

MedRx, Inc is not responsible for problems resulting from installation of 
unapproved software or hardware. In the event of unapproved software or 
hardware installed on the system causing a conflict, MedRx will service the 
product for a fee to be determined at the time of service. 

Any extension of this warranty past the initial one-year warranty is subject to the 
following (where applicable). 
1. A $300 deductible per repair. 
2. Extended warranty does not include cables, connectors or peripherals. 
3. Extended warranty of the Video Otoscope covers optics only. 
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